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This workbook has been developed for the ChaMPs CPD workshop on “Using and 
analysing WEMWBS to measure the impact of interventions in improving mental 
wellbeing”.   
It is based on the WEMWBS practice-based user guide produced by Coventry City 
Council, NHS Coventry, and Warwick Medical School, and authored by Rebecca Putz, 
Kate O’Hara, Frances Taggart and Sarah Stewart-Brown, September 2012: Using 
WEMWBS to measure the impact of your work on mental wellbeing:  A practice-based 
user guide   
 
Who is this for? 
The workshop and workbook is for staff who are using the Warwick-Edinburgh Mental 
Wellbeing Scale (WEMWBS), or would like to, to evaluate the effectiveness of their 
interventions in improving mental wellbeing.   
 
The purpose is to equip staff with the knowledge and skills to effectively collect and analyse 
data collected through the Warwick-Edinburgh Mental Wellbeing Measurement Scale 
(WEMWBS). 
 
Learning outcomes: 
At the end of the workshop/workbook participants will have the knowledge and tools to equip 
them to measure mental wellbeing as an outcome of their intervention, through: 

• setting-up and administering the WEMWBS measurement tool with participants 
• analysing the data and calculating a mean score 
• interpreting the results to show impact  

 
It addresses Public Health competencies: 
KH8  Analysis of data on a small area basis and understanding of the limitations of the 
analysis 
KH26  The principles and methods of evaluation 
 
Further information is available at 
http://www.champspublichealth.com/page.aspx?pageid=304&ParentID=0  
 
This workbook has been adapted for use by:  
Jude Stansfield, Mental Health & Wellbeing Programme Manager, ChaMPs  
Brendan Collins, Research Fellow in Health Economics, NHS Wirral/ University of Liverpool 
Dr Hannah Timpson, Applied Health and Wellbeing Partnership, Centre for Public Health, 
LJMU 
Gayle Whelan, Applied Health and Wellbeing Partnership, Centre for Public Health, LJMU 
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1.0  Introduction: mental wellbeing and WEMWBS 
 
 
1.1 Background 
 
Improved mental wellbeing is a key national outcome and a fundamental part of being a 
healthy and resilient individual. It is a local priority for most of the Health & Wellbeing Boards 
in Cheshire and Merseyside. WEMWBS is a measure for the ‘self-reported wellbeing’ 
indicator in the Public Health Outcomes Framework.  
 
In order to achieve a consistent and comparable approach and to understand and improve 
best practice ChaMPs recommends that sWEMWBS is used across Cheshire and 
Merseyside, where appropriate, to measure improvements in mental wellbeing. 
 
1.2 What is mental wellbeing? 
 
Mental wellbeing is about having control and influence, a sense of meaning, belonging and 
connection and the capability to manage problems and change. It is therefore central to 
parenting, educational attainment, employment & work productivity, community participation 
and cohesion, crime and safety. 
 
Mental wellbeing is also a key outcome for and a determinant of physical health, for 
example: 

• Effectively managing long term conditions  
• Reducing obesity, heart disease and other illness  
• Making healthy life choices  
• Recovery from illness 

 
1.3 What is WEMWBS? 
 
The Warwick-Edinburgh Mental Wellbeing Scale (WEMWBS) is a validated measure of 
mental wellbeing that has been used nationally, regionally and locally and seen as an 
effective tool. There is a 14-item and a 7-item (sWEMWBS) questionnaire that produces a 
single score. See Appendix 1. It is self-completed (for people aged 13+) to record 
‘statements about their thoughts and feelings over the past two weeks’. 
 
1.4 Why use WEMWBS? 
 
The findings can be used to establish whether a specific population has low, average or high 
mental wellbeing. This can be used to identify which groups are most in need and where to 
target investment. It can be used to measure changes over time or differences to other 
population groups. WEMWBS can also be used before and after an intervention (at least two 
weeks duration) to establish if mental wellbeing has improved. Having a control group would 
strengthen any findings of the impact that the intervention has had on mental wellbeing. 
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1.5 Current population baseline 
 
A population baseline for mental wellbeing already exists for each locality within Cheshire & 
Merseyside1 as well as regionally2 and nationally3,4. This means that there is a score for the 
population averages that you can compare your intervention group with. It also allows 
improvements to be measured across the whole population over time. 
 
National SWEMWBS mean score 25.3  
North West 27.7  
Cheshire & Merseyside 28.21 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Results for the 2012/13 NW survey will be available in April 2013 from the NW Public Health 
Observatory. 
 

                                                
1 http://www.champspublichealth.com/page.aspx?pageid=866&ParentID=0  
2 Deacon et al (2010) The North West Mental Wellbeing Survey 2009, NWPHO 
http://www.nwph.net/nwpho/publications/NorthWestMentalWellbeing%20SurveySummary.pdf 
3 see the Health Survey for England 2010 
http://www.ic.nhs.uk/webfiles/publications/003_Health_Lifestyles/HSE2010_REPORT/HSE2010_Ch7
_Well_being_health_and_work.pdf 
4 Understanding Society, the UK’s Household longitudinal study 2011 
http://research.understandingsociety.org.uk/files/research/findings/early- 
findings/9%20Early%20findings%20Chapter%209.pdf 
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1.6 What interventions can be measured? 
 
Q 1. What interventions are you currently using WEMWBS on or plan to?: 
 
 
 
 
 
 
 
 
There are many examples of WEMWBS being used already with different intervention 
groups within Cheshire & Merseyside as well as nationally. For example 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
WEMWBS could be used to measure improvements in wellbeing within services and 
interventions such as: 
 

• Social prescribing  
• Health Trainers 
• Employment support  
• Parenting support  
• Workplace health  
• Community involvement and development projects  
• Volunteering 
• Self-care/condition management  
• Befriending 

Liverpool John Moore’s University evaluated Wellbeing Sefton, a social prescribing range 
of programmes.  A baseline questionnaire indicated 88% had lower wellbeing (20.83) than 
the Sefton average (27.59), showing the right people were accessing the service.  Data 
was collected for 18 months with a post-intervention questionnaire after three to six 
months. The programmes all showed an improvement in wemwbs and shifted the mean 
wellbeing from low to moderate (25.14).  The range of improvement was from 2.98 to 5.00 
with a weighted average of 4.31. 
 

The Warrington Positive Thoughts programme is a seven week therapeutic intervention 
to manage feelings.  sWEMWBS is completed on weeks one and seven. A three month 
evaluation with 21 people showed an increase in mean sWEMWBS of 11%.   

Sefton Sanctuary was set up to address the physical and mental health of women aged 
40-60 in the more deprived South of Sefton.  It was decided that the best way to do this 
was by going to community venues which women in this target group accessed. A 5-hour 
health and wellbeing event was carried out in 6 community venues in South Sefton. The 
intervention offered a health check, information around the 5 ways to wellbeing with 
individuals making pledges, complementary therapies, and representatives from other 
health agencies who were available on the day with specific information. Evaluation was 
conducted over 3 months and found that average mental wellbeing increased from 24.7 to 
25.2, shifting the percentage of those with higher wellbeing from 3.5% to 6.1%. 
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IMPORTANT 
WEMWBS is not designed to be an individual diagnostic tool, or to be part of the 
intervention itself. By this, we mean that it should not be used to ‘diagnose’ a person’s poor 
mental wellbeing.  It is used to evaluate the whole intervention. When completing the tool, 
however, this may raise issues for individual that they want to discuss with others.  Other 
tools exist to support discussing mental wellbeing with individuals and groups.  E.g. Five 
ways to wellbeing, Fair deal for wellbeing discussion kit.  See: 
www.champspublichealth.com paper on Discussing mental wellbeing during brief 
interventions 
www.ourlife.org.uk discussion kit Fair Deal for Wellbeing 
 
If a participant is worried about their mental distress, or any other aspect of their health, 
please advise them to speak to their GP. Alternatively they can contact local helplines or 
websites. Other resources include:  
Living Life to the Full –  www.llttf.com 
NHS Choices –  www.nhs.uk/LiveWell/mental-wellbeing 
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2.0  How to use WEMWBS to measure mental wellbeing 
 
2.1 Gaining permission 
WEMWBS is free to use. HOWEVER, you must seek permission to use WEMWBS by 
completing a registration form Prof Sarah Stewart-Brown:  Sarah.Stewart-
Brown@warwick.ac.uk. The Reproduction copyrights for WEMWBS are as follows and must 
be presented on any copy of WEMWBS used:and contacting Dr Frances Taggart:  
frances.taggart@warwick.ac.uk or  
“Warwick-Edinburgh Mental Well-being Scale (WEMWBS) © NHS Health Scotland, 
University of Warwick and University of Edinburgh, 2006, all rights reserved”.   
If you produce any documents outlining your WEMWBS results (such as reports, 
presentations) you must also reference the tool accordingly, as above. 
 
2.2 Planning 
Take time to consider what it is your project is aiming to achieve. The things you are 
measuring are important. WEMWBS data that you collect will show the impact of your 
project on participants’ mental wellbeing. 
 

Q 2.  Before you start.. 
 What might you need to consider before starting to use WEMWBS in your project? 
Use this space to write down your thoughts: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
See Appendix 2 
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2.3 Sample selection 
 The number of people you ask to complete WEMWBS will depend on the nature of your 
project.  
 

 Q3.  What types of projects are you involved in? 
 
 
 
How long does the intervention last? 
 
 
How many people participate? 
 
 

 
2.4 Timescales 
In order to identify the impact of a project, WEMWBS data must be collected at the start and 
end. 
If you have a long project, you might choose to also collect data mid-way through, to identify 
progress. If your project is discrete (has a clear start and end point) you may be able to 
easily identify when this information will be collected (for example, during the registration to a 
project, and at the final session).  

Example 
If you have a 12-week project, you could ask participants to complete the WEMWBS 
survey in week 1, upon registration. You could then ask participants to complete the 
follow-up survey during their final session in week 12. Alternatively, if you know that a 
lot of people drop-out of your project from about the 8th week, you may wish to ask 
people to complete their follow-up WEMWBS after 8 weeks to maximise your sample 
size.  
You may wish to also ask participants to complete WEMWBS at a mid-point, such as 6-
weeks into the course. This will enable identification of early progress.  

But what if my project is open-ended… 
If your project is open-ended and does not have a structured start and finish, you may wish 
to recruit a selection of participants as they register. The timescale for the collection of 
follow-up data will be dependent on the nature of your project, but you could collect their 
follow-up data at 8-10 weekly intervals, and/ or when they decide to leave (if sooner). If 
possible, you may also collect WEMWBS at a time after the project has finished to see if 
mental wellbeing levels are sustained beyond the life of the intervention.  
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2.5  REMEMBER 
WEMWBS asks people to reflect on each statement within the past 2 weeks, therefore it is 
important that there is a minimum 2 week gap between the before and after questionnaires.  
 
Issues to consider: 
How easy is it to contact participants, to implement the before and after surveys? 
Is it possible to conduct a follow-up WEMWBS within your project? 
See also Section 2 of the Coventry practice-based user guide. 
 
2.6  Completing WEMWBS 
WEMWBS is designed for participants to complete themselves. WEMWBS has not been 
tested for interviewer completion (with the interviewer reading the statements out and filling 
in the responses for them). This is therefore not recommended unless necessary for helping 
people with visual impairments or reading difficulties. Please maintain privacy when reading 
out statements. See the full user guide for more details 
http://www.healthscotland.com/documents/2702.aspx  
It is useful to be prepared and know what people completing the form might ask you about.  
See Appendix 1 for copies of WEMWBS and sWEMWBS. 
 Q 4. Have a go at completing the WEMWBS survey yourself  
What did you think about this? How did it make you feel? 
 
 
 
 
 
Do you have any questions? 
 
 
 
 
Did all questions seem straightforward? 
 
 
 
 
 

Now you have a better understanding of what it is like to complete the survey, you will be 
able to describe this to potential participants. 
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2.7 Introducing WEMWBS to potential participants 
Before you collect any data, you need to explain WEMWBS to potential participants, and 
gather their consent to take part in the survey.  
 
WEMWBS can be described to potential participants as ‘statements about their thoughts 
and feelings in the past two weeks’. Explain that you would like to ask them about these 
statements before they start the project and then again at the end (you may also ask them at 
a mid-point) to follow the effects of this project. Explain that WEMWBS has been specifically 
designed and tested for measuring the impact of projects such as this one.  
 
Gaining consent to participate in evaluation  
It is important to invite participants to take part in the project evaluation. Participants should 
be made aware that WEMWBS is not part of the intervention/ service, that they do not have 
to complete the questionnaire if they don’t want to, and their decision will not affect the 
service offered to them.  
  

Q 5. How might you check that people are happy to participate? 
 
 
 
 What might be included in a consent form? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
See Appendix 2 
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2.8 Are there any risks to participants? 
WEMWBS is an ideal tool to use, as it generates information regarding positive mental 
wellbeing in a timely and cost-effective manner. However, occasionally, reflection on the 
WEMWBS statements may generate distress. See page 6 of the Coventry practitioner user 
guide.   
 
For participants to recognise that their mental wellbeing is not good is not necessarily a bad 
thing. It can be the first step towards taking action to feel better.  
Provide information to the participant on where they can seek help with distress. It may be 
that the intervention is appropriate for the participant to discuss any issues.  
 
REMEMBER that WEMWBs is not an intervention tool. The practitioner can use other tools, 
such as the Five Ways to Wellbeing, to discuss mental wellbeing with participants.  See the 
ChaMPs brief guide on Discussing mental wellbeing during brief interventions. 
http://www.champspublichealth.com/writedir/4349Discussing%20wellbeing%20during%20bri
ef%20interventions.pdf  
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Quick Checklist for setting up using WEMWBS 
 
Before you start using WEMWBS check that you have… 

�Understood WEMWBS is to evaluate change in mental wellbeing as a direct result 
of a project intervention and that it is not a diagnostic tool. 

�Sought permission from University of Warwick (frances.taggart@warwick.ac.uk / 
Sarah.Stewart-Brown@warwick.ac.uk) 

�Decided whether using WEMWBS/SWEMWBS 

�Decided on time frame/interval  – before, during, after; at start and eight weeks  

�The timeframe is at least two weeks apart 

�Decided on who to distribute to – whether there are enough participants 

�All participants are aged 13 years and older 

�Printed out all relevant document (including information sheets/consent forms and 
WEMWBS questionnaire sheets) 

�Information includes an explanation of the research, that it is anonymous and their 
decision to participate or not does not affect the service offered. 

�Ensured any potential risks, such as distress, disclosure of personal information, 
data protection issues etc are fully considered 

�Agreed and included any additional information to collect at the same time as 
WEMWBS, such as age, gender, ethnicity, employment status 

�Agreed how you will record the WEMWBS responses – on an Excel  spreadsheet,  
statistical package such as SPSS. 

�Ensured the project team is fully aware of all aspects of the research and why 
these questionnaires are being used. All staff should be fully briefed on methods such 
as assigning identifiers and what to do with completed questionnaires.  

�Ensured you meet any information governance requirements of your organisation 
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3.0 Collecting the data 
 
3.1  Assigning identifiers 
Each person completing a WEMWBS questionnaire will need to be assigned a unique 
identifying code so that their responses at each stage can be compared. This identifier can 
be an initial, a number or a code, but cannot be the individual’s full name. This identifier 
needs to be recorded so that any member of staff can refer to this at any stage of the 
research. A good idea is to assign this participant code at registration, next to their name, 
and to store this electronically on a password protected file. This way you can check which 
code you have given to which participant when it comes to the follow-up survey/s. This 
information should be saved separately from where you save your WEMWBS data. You may 
need this identifier to match up your data if you want to analyse by any socio-demographic 
group that is not in the WEMWBS datasheet. 
 
The Coventry practitioner guide provides an example of tracking data, see page 9-10. 
 
3.2 Additional information 
For each questionnaire, it is a good idea to collect more information so that you can 
understand more about the individual taking part in the research. The individual can 
complete this information at the same time as completing the WEMWBS questionnaire. This 
form could for example, include the project title, an identifier, what stage of the research the 
form is (before during or after), the date, any demographic information such as age and 
ethnicity, along with any notes relating to the individual but which are not identifiable, such 
as completed intervention at 8 weeks, dropped out at week 4 etc. 
 
3.3 Storing data 
Once you receive completed questionnaires it is best to check them and to make notes on 
the front sheet if there are any missing sections for example and ensuring the unique 
identifying code is there.  The paper questionnaires should be stored in a locked filing 
cabinet. Hard copies of names and corresponding participant codes should not be stored – 
this needs to be kept electronically on a password protected computer.  Only members of 
the project team must access the files.  
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4.0  Analysing and Interpreting the Data 
 
4.1 Missing data 
For the SWEMBWS all 7 questions need to be answered. Do not analyse any questionnaires 
where data is missing.  
For the 14 item WEMWBS we recommend not reporting on any questionnaires where less 
than 11 out 14 answers have been completed. If more than three are missing then do not 
include the questionnaire in analysis.  For those questionnaires with 11, 12 or 13 questions, 
a weighted average can be used, so if 11 questions are answered, add up the answers and 
multiply by 14/11 (1.273), for 12 questions multiply by 14/12 (1.167), for 13 answers multiply 
by 14/13 (1.077). The Excel worksheet supplied does this automatically. 
 

Q. 6  
If you get some time, try calculating the adjusted scores below. 
 

Answers in appendix 2 

Number of 
questions 
answered 
 

WEMWBS 
Score 

Adjusted 
WEMWBS 
score 

11 36 45.82 
12 41   
13 41   
9 28   
14 45   
 
 

4.2  Inputting data 
It is good practice to record the data from the completed WEMWBS questionnaires as you 
receive them, or at the end of each stage once all have been submitted.  The data can be 
entered onto an excel spreadsheet.  
A template worksheet has been prepared and can be downloaded at 
http://www.champspublichealth.com/page.aspx?pageid=866&ParentID=0  
 
Record data for each individual on a separate row: 

i. Unique identifier code – on both questionnaires 
ii. Date of completion of first (pre) questionnaire  
iii. Score of each question (1-5) from first questionnaire 
iv. Sum of scores (the worksheet calculates this automatically) 
v. Date of completion of second (post) questionnaire 
vi. Score of each question (1-5) from second questionnaire 
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vii. Sum of scores (the worksheet calculates this automatically) 
viii. Record any additional data you are collecting e.g. age 

  
The SWEMWBS worksheet also calculates whether the score denotes low, moderate or high 
wellbeing, according to the NW Mental Wellbeing Survey 2009 baseline.  This can be useful 
to confirm if you are targeting the correct participants e.g. people with low wellbeing. 
(sWEMWBS low=7-22, moderate 23-32, high 33-35; mean 27.7) 
The worksheet also does a check that the questionnaires were done 2 weeks apart. 
 
4.3 Analysing data  
You may be working with a team and a data analyst to help you understand the results. It will 
be between your project team and the data analyst to work together and put the WEMWBS 
results in the context of your project. Your worksheet should already have been set up to 
work out the WEMWEBS scores for each stage. You might want to do some additional 
analysis that is not in the worksheet such as by subgroup in your intervention. Remember 
that you can save more copies of the worksheet and put different data into it.   
 
i) Calculate the change 
For each entry, subtract the sum of scores 1 (first questionnaire) from the sum of scores 2 
(second questionnaire).  If the first sum is greater this will give a minus (-) and denotes a 
decrease in wellbeing.  The worksheet  includes a column on whether the change is 
positive i.e. resulted in an  increase in wellbeing and meaningful, i.e. greater than 3 for 
WEMWBS or 2 for SWEMWBS. 
 
ii) Calculate the mean change 
Add together all the change scores from i) above. Divide this by the total number of 
participants*.  This is the mean change in wellbeing from the beginning of the intervention to 
the end.  
* see below 
 

Q7.  Quick calculation: 
For the group of 10 participants below: 
What is the mean SWEMWBS of participants before the course? 
What is the mean SWEMWBS of participants after the course? 
What is the mean change in SWEMWBS ? 
 
R1  pre score 21   post score 21 
R2  pre score 14   post score 19 
R3  pre score 12   post score 18 
R4  pre score 10   post score - 
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R5  pre score 22   post score 21 
R6  pre score 19   post score 22 
R7  pre score 17   post score -  
R8  pre score 23   post score 25 
R9  pre score 20   post score 22 
R10  pre score 22   post score 26 
 
 

 
4.4  Measuring the impact of your work 
 
Meaningful increases in WEMWBS:   
A three to eight points difference in WEMWBS score is considered meaningful.  
For sWEMWBS a two to four points increase can be considered meaningful.  
 
The total number of participants and completed questionnaires needs to be clear in the 
interpretation of your results. 

Q8. How would you describe the change in wellbeing from the results in Q7? 
 
 
 
 
 

4.5 Statistical significance 
Whether a difference is statistically significant or not will depend on the number of 
participants completing WEMWBS questionnaires, the average change, and the amount of 
variation in scores.  So it is not possible to say for certain what sample size will produce 
statistically significant results, but as a general minimum at least 30 before and after values 
will be needed for statistical significance. That is not to say that you should not use 
WEMWBS to evaluate an intervention with less than 30 clients as you may still get useful 
results even if they are not statistically significant. 
  
In terms of statistical tests, results from WEMWBS can be compared several ways. If you 
have before and after data for more than around 100 clients, you can use a paired sample t 
test – this assumes that your data is normally distributed (i.e. has a bell shaped distribution), 
if you are not sure if your data is normally distributed you get a rough idea by looking at your 
data in a histogram or can do a test of normality in SPSS. 
See Appendix 3 for more information on statistical tests. 
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5.0 Reporting on your work 
It is useful to document details about your intervention and its impact on project participants. 
Alongside the data you may want to talk about the mechanism through which you think 
clients subjective wellbeing has increased and include additional interviews or information 
from clients or project staff to understand how smoothly the project has been running, and 
what their perceptions are of the project itself. 
The methodology behind your research involving WEMWBS will need to be included in a 
final report, which explains the stages to your research. For example:  

• Recruitment and actual numbers including details of those who may have dropped out 
or number of uncompleted questionnaires 

• WEMWBS questionnaire stages – before, during or after 
• Explain any additional research you may have conducted, such as satisfaction 

surveys or interviews with clients/staff. 
• Include reference to local, regional or national baseline scores 

 
5.1 Communicating your results 
It is useful to communicate your results in a final paper/ report, even if there was no positive 
change: 

• to all members of your team. 
• to your clients/ project participants - it is helpful for them to hear the outcome of the 

research, and to also to understand the findings – the impact that the project has on 
mental health and wellbeing.  

• to Champs to support dissemination of best practice locally  
• In agreement with the permission to use, to the University of Warwick 

(frances.taggart@warwick.ac.uk or Sarah.Stewart-Brown@warwick.ac.uk). 
• Also consider publishing your work in a journal e.g. Journal of Public Mental Health 

http://www.emeraldinsight.com/products/journals/author_guidelines.htm?id=jpmh&PH
PSESSID=6v98ts1n7in4tildkk5dcucjd6  

 
 
Useful links 
 
WEMWBS user guide http://www.healthscotland.com/documents/2702.aspx 
 
NW report providing local baselines - Deacon et al (2010) The North West Mental Wellbeing 
Survey 2009, NWPHO 
http://www.nwph.net/nwpho/publications/NorthWestMentalWellbeing%20SurveySummary.pd
f 
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The Warwick-Edinburgh Mental Well-being Scale  

(WEMWBS)  
Below are some statements about feelings and thoughts.  

Please tick the box that best describes your experience of each over the last 2 weeks  

STATEMENTS None of 
the time Rarely Some of 

the time Often All of the 
time 

I’ve been feeling optimistic about the 
future  1 2 3 4 5 

I’ve been feeling useful  1 2 3 4 5 

I’ve been feeling relaxed  1 2 3 4 5 

I’ve been feeling interested in other 
people  1 2 3 4 5 

I’ve had energy to spare  1 2 3 4 5 

I’ve been dealing with problems well  1 2 3 4 5 

I’ve been thinking clearly  1 2 3 4 5 

I’ve been feeling good about myself  1 2 3 4 5 

I’ve been feeling close to other 
people  1 2 3 4 5 

I’ve been feeling confident  1 2 3 4 5 

I’ve been able to make up my own 
mind about things  1 2 3 4 5 

I’ve been feeling loved  1 2 3 4 5 

I’ve been interested in new things  1 2 3 4 5 

I’ve been feeling cheerful  1 2 3 4 5 

 
 

Warwick-Edinburgh Mental Well-Being Scale (WEMWBS) 
© NHS Health Scotland, University of Warwick and University of Edinburgh, 2006, all rights 

reserved. 
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The Short Warwick-Edinburgh Mental Well-being Scale  
(SWEMWBS)  

Below are some statements about feelings and thoughts.  
Please tick the box that best describes your experience of each over the last 2 weeks  

STATEMENTS 
None 
of the 
time 

Rarely 
Some 
of the 
time 

Often 
All of 
the 
time 

I’ve been feeling optimistic about the 
future 1 2 3 4 5 

I’ve been feeling useful  1 2 3 4 5 

I’ve been feeling relaxed  1 2 3 4 5 

I’ve been dealing with problems well  1 2 3 4 5 

I’ve been thinking clearly  1 2 3 4 5 

I’ve been feeling close to other people  1 2 3 4 5 

I’ve been able to make up my own 
mind about things  1 2 3 4 5 

 
 
 

Warwick-Edinburgh Mental Well-Being Scale (WEMWBS) 
© NHS Health Scotland, University of Warwick and University of Edinburgh, 2006, all rights 

reserved. 
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Appendix 2:   
 
 
Q2 suggested answers: 

• Is there a project team in place to collect the information? 
• Do the project team understand what mental wellbeing is and why it is important for 

health? 
• Do the project team understand what WEMWBS is and how it is used? 
• Do the project team fully understand the aims and objectives of the project?  
• Timescales (is the project open-ended, or does it have a clear start and end point?) Is 

it possible to complete a follow-up survey? 
• How big is the project (how many people attend/are part of it)? 
• Is there a structure in place for collecting, recording and managing WEMWBS data? 
• Do team members know how to track individuals over time (to enable collection of 

before and after WEMWBS scores, to identify change) ? 
 
Q 5 suggested answers: 

• Information about the project and how the information they provide will be used 
• Assurance that responses will remain anonymous when project results are reported 
• All WEMWBS forms will be kept secure and confidential 
• If the information is stored electronically, it will be kept on a password protected 

computer, and only the project team will have access to this 
 
Q 6 answers: 
  
   
Number of 
questions 
answered 

WEMWBS 
Score 

Adjusted 
WEMWBS 
score 

11 36 45.82 
12 41 47.83 
13 41 44.15 
9 28 do not score 
14 45 45 
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Appendix 3: Statistical tests 
 
Wilcoxon Signed Rank Test 
The WEMWBS and SWEMWBS workbook you will get automatically does a Wilcoxon 
signed rank test, this is appropriate where you have a small sample or data is not normally 
distributed. With a larger sample the results of this test are similar to the results you would 
get with a paired sample t test, so it is fine to use this even if you have a bigger sample. 
 
Doing a paired sample t-test in Excel 
You can do a paired sample t test using the ‘analysis toolpak’ [sic] add-in in Excel, this is a 
free add-in that comes with Excel. You do not need a disk or admin rights to install it.  
Excel 2003 
1. On the Tools menu, click Add-Ins.  
2. In the Add-Ins available box, select the check box next to Analysis Toolpak, and 

then click OK.  
Tip    If Analysis Toolpak is not listed, click Browse to locate it. 

3. If you see a message that tells you the Analysis Toolpak is not currently installed on 
your computer, click Yes to install it.  

4. Click Tools on the menu bar. When you load the Analysis Toolpak, the Data 
Analysis command is added to the Tools menu.  

Excel 2007 

1. Click the Microsoft Office Button , and then click Excel Options.  
2. Click Add-Ins, and then in the Manage box, select Excel Add-ins.  
3. Click Go.  
4. In the Add-Ins available box, select the Analysis ToolPak check box, and then click 

OK.  
o Tip If Analysis ToolPak is not listed in the Add-Ins available box, click Browse 

to locate it.  
o If you get prompted that the Analysis ToolPak is not currently installed on your 

computer, click Yes to install it.  
5. After you load the Analysis ToolPak, the Data Analysis command is available in the 

Analysis group on the Data tab.  
Excel 2010 
To confirm whether you already have the Analysis Toolpak installed, open the Data tab on 
the Excel ribbon. If the Analysis Toolpak is installed, you should see a Data Analysis button 
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on the Ribbon, like the one shown here. If the 
Analysis Toolpak is not installed, go to the File tab and select Options in the left column. In 
the Excel Options Window, select the Add-Ins category on the left. Near the bottom of this 
window, you see Excel Add-ins already selected in a drop-down menu labeled Manage. 
Click the Go button next to this drop-down. 

The Add-Ins dialog will open. Here, you can 
select the check box next to Analysis Toolpak (and any other add-ins you want to install). 

Click OK.  
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Once you have done this, on the data tab on the Excel ribbon you will have a button that 
says ‘Data Analysis’.  

 
 
If you click on ‘Data analysis’ you can do a paired samples t test, scroll down to ‘t test: paired 
samples for two means’. You will need your before and after WEMWBS totals data to be 
arranged in columns. then select your ‘before’ or baseline WEMWBS data as variable 1, and 
‘after’ WEMWBS data as variable 2, and if you have selected the column titles then click the 
box that says ‘labels’, then click ‘ok’.  

 
Interpreting a paired sample t test 
 
The t test will give you an output in a new worksheet which will look something like this (the 
comments column has been added here to tell you more about what each value means): 
 
  Baseline WEMWBS 12 week WEMWBS Comments 

Mean 49.47008547 51.21937322 These are the averages 
for the two groups. 

Variance 112.912674 104.2003093 Variance is the standard 
deviation (SD) squared, 
so if you want to 
calculate SD, put in 
=SQRT(then click on 
these cells) 

Observations 351 351 This is how many people 
there was before and 
after data for. 
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Pearson Correlation 0.628192431  This is the correlation 
between people’s before 
and after scores (it will 
be between 0 and 1 
where 1 is a perfect 
correlation, 0 is no 
correlation) 

Hypothesized Mean Difference 0  Don’t worry about these 

df 350  Don’t worry about these 

t Stat -3.645167516  Don’t worry about these 

P(T<=t) one-tail 0.000153871  Don’t worry about these 

t Critical one-tail 1.64921887  Don’t worry about these 

P(T<=t) two-tail 0.000307741  This is the significance 
level. Anything less than 
0.05 can be said to be 
significant at the 95% 
level.  

t Critical two-tail 1.966765003   Don’t worry about these 

 
 
If you have data for more than two time points, say baseline, 12 weeks and six months, you 
can do more than one paired sample t-test to see if there has been a significant change 
between baseline and 12 weeks, 12 weeks and six months, and baseline and six months. 


